Appendix 2.1A

Appendix 2.1A: baytrends—Quick Start Instructions

This document contains brief instructions for getting started with baytrends. Specifically, the following
issues are covered.

e How to access the help files for specific baytrends functions.

e How to open and run example scripts provided with the help files.

e Instructions on how to open and navigate the GAM trend scripts.

e Instructions on where to make changes to default options and how to run the scripts.
e Example MS Word and csv output.

e An explanation of what is in the csv output files.

¢ How to access the help files for specific functions.

A note to potential users of the attached material. Some of the figures in this document are too small
too effectively read in the printed form. It is strongly recommend that users open the files as described
in this document and organize the windows on their monitor to emulate the figures included in this
document. Then use the included figures to help navigate what information to review in detail from the
user’s monitor.
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1.0 Installing baytrends

These instructions assume that you have already installed R and R Studio on your workstation.

Uncompress distributed zip file
Acquire the baytrend start up
files and organize them in a
location that you have regular
access.

i Organize ~ Include in library = Share with = Burn Mew folder
In the example to the right, we 4 g Dropbox 4 Name ’
located the files in the folder 44 CBP -
E:\Dropbox\CBP. II /& cbpTrends ¢ copbam
@ install baytrends

. . @ mySettings
The primary folder is called
. g . o work30
cbpTrends’ and contains four &) Sreadme et

additional subfolders. w H

Examine the $readme.txt file for a detailed description of the folders.

For now, it is important to know that the install baytrends folder contains files that you
will need to complete Section 1.0, related to installing baytrends. The Work30 folder
contains files that we’ll use in Sections 3.0 of these instructions.
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Install libraries that support baytrends

1. Open R Studio.

2. Click on the ‘Files’ tab in the
bottom right panel.

3. Navigate to the folder with
‘chkLibraries.R’. (e.g.,
E:\Dropbox\CBP\cbpTrends
\install baytrends)

4. Click on chkLibraries.R (the
file should open in the
upper left panel).

5. Using your mouse, in the
upper left panel, click and
drag to highlight all rows in
chkLibraries.R.

6. Click the Run button.

You will see the R code that
you just highlighted being
executed in the Console
window. This process
downloads and installs a
series of R packages that
are required for running the
baytrends package. This
process will take several
minutes.

IOy, S—
File fon Coce Yiew Plots Session Build Debug Profile Jools Help

. Aogns -

: phgtest

stop(pastels, “package not found

a0
'\3/

Install baytrends

1. From within R Studio, click
Tools > Install Packages.

2. Select ‘Package Archive
File ...” from the ‘Install
from’ drop down list.

Install Packages
Install Packages
Install from: ? Configuring Repositories

] Install from:

[ Repository (CRAN, CRAMextra)

[Package Archive File (zip; targz) -

Packages (separate multiple with space or comma):

| q Package archive:

Install to Library:
[ Ci/Users/jonharcum/Documents/R/R-33.3/library [Default] ~ ]

Browse...

Install to Library:
[ Ci/Users/jon.harcum/Documents/R/R-3.3.3/library [Default] -

Instal\ dependencies

Install Cancel
Install Cancel —
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3. Click the Browse button and
navigate to the location of
the baytrends_x.x.x.tar.gz
file and click on the file. (In
our case, the file is located
in ...\cbpTrends\install
baytrends)

4. Click Install. Once this
process has finished
executing, the baytrends
package is successfully
installed.

Install Packages

Install from:

Package Archive File (zip; .targz)

Package archive:

../install baytrends/baytrends_0.2.5.tar.gz

Install to Library:

Browse...

C:/Users/jon.harcum/Documents/R/R-3.3.3/library [Default]

-

Install Cancel
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2.0 baytrends Primer

baytrends is similar to
other R packages, Part
1—you must load any

library that you want to

use every time you start
R Studio.

1. To get started, click File>
New File > R Script.

You will get an ‘Untitled?’
program file to work with.

2. Enter ‘library(baytrends)’
as it is shown to the right
and click Run.

Examine the Console. This
is a normal load.

Note, that you might get
slightly different results
depending of package
versions.

You should get in the
practice of scanning the
loading to look for abnormal
results such as a library not
found.

[Workspace loaded from E:/Dropbox/.RData]

= Tibrary(baytrends)
Loading required package: Tubridate
Attaching package: ‘Tubridate’

The following object is masked from ‘package:base’:

date
Loading required package: mgcw
Loading required package: nlme

This is mgcov 1.8-17. For overwview type "help(“"mgcv-package")'.

Loading required package: smwrQw
Loading required package: dataRetrieval
Loading required package: smwrBase

Loading required package: smwrGraphs

This information iz preliminary or provisional and is subject to rewision. It is being pr
ovided to meet the need for timely best science. The information has not received final a
pproval by the U.5. Geological Survey (USGS) and is provided on the condition that neithe
r the USG5 nor the U.5. Government shall be held Tiable for any damages resulting from th
e authorized or unauthorized use of the information. Although this software program has b
een used by the USGS, no warranty, expressed or implied, is made by the USGS or the U.S.

Government as to the accuracy and functioning of the program and related program material
nor shall the fact of distribution constitute any such warranty, and no responsibility 1
s assumed by the USGS in connection therewith.

Loading required package: smwrStats

Although thiz software program has been used by the U.5. Geological Survey (USGS), no war
ranty, expresszed or implied, 1z made by the USGS or the U.5. Government as to the accurac
v and functioning of the program and related program material nor shall the fact of distr
ibution constitute any such warranty, and no responsibility is assumed by the USGS in con
nection therewith.

This information is preliminary or provisional and is subject to rewvision. It is being pr
ovided to meet the need for timely best science. The information has not received final a
pproval by the U.5. Geological Survey (USGS) and is provided on the condition that neithe
r the USG5 nor the U.5. Government shall be held Tiable for any damages resulting from th
e authorized or unauthorized use of the information. Although this software program has b
een used by the USG5, no warranty, expressed or implied, is made by the USGS or the U.5.

Government as to the accuracy and functioning of the program and related program material
nor shall the fact of distribution constitute any such warranty, and no responsibility i
= assumed by the USGS in connection therewith.

Attaching package: ‘smwrQw’

The following object is masked from ‘package:utils’:
\J"| ew

** bhaytrends Notice:** This software program is preliminary or provisional and iz subject
to rewision. This software program is for testing only, no warranty, expressed or implie
d, 1= made as to the accuracy and functioning of the program and related program material
nor shall the fact of distribution constitute any such warranty, and no responsibility 1
s assumed by in connection therewith. This software 1s provided 'aA5 IS.'

>

|| File Edit Code View Plots Session Build Debug Profile Tools Help
1e- -6 & 2 [ ~| Addins -
@ Untitled1* =0
AR | DSource onsave | Q A -| 1| - [=#Run | [5% | | #Source ~| =
1
2 NlHibrary(baytrends)
21 [Top Level} = R Seript +
Console E:/Dropbox/ i )
Iype giJ) TO guiT K. i

1

1]
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baytrends is similar to
other R packages, Part
2—nhelp files are built-in
with the software.

Click on baytrends from the
Package tab to see the help.

Files Plots Packages Help Viewer
Install | @ Update

Mame Description Version
[] basebtenc Tools for bases4 encading 01-3
[ bayesplot Plotting for Bayesian Models 110
[7] BaylorEdp R Package for Baylor University Educational Psychology Quantitative Courses 05
[7] baytrends Long Term Water Quality Trend Analysis 025
[ ed Boost C++ Header Files 1620-1
[] binom Binomial Confidence Intervals For Several Parameterizations 111
[] bitops Bitwise Operations 106
[] boot Bootstrap Functions (Originally by Angelo Canty for 5) 1318
] brew Templating Framewark for Report Generation 106
] broom Convert Statistical Analysis Objects into Tidy Data Frames 042

From here you will see a list of
functions that you can access.

Click on ‘gamTest’ to see the
help for gamTest.

Files Plots Packages Help Viewer
& 5 0 &
R: Long Term Water Quality Trend Analysis -

Long Term Water Quality Trend Analysis

~)

Documentation for package ‘baytrends’ version 0.2.5

« DESCRIPTION file
» Package NEWS.

Help Pages

analysisOrganizeData Analysis Organization & Data Preparation

closeOut Document Processing Time and Other Session Time

dataCensored Table: Sample Chesapeake Bay Program Data, 1985-2015

gamDiff Compute an estimate of difference based on GAM results
amPlotDis Plot censored gam fits vs. time

gamTest Perform GAM analysis

layerLukup Table: Layer lookup list

loadData Load/Clean CSV and TXT Data File

parameterlist Table: List of valid parameters for CBP trend analysis

saveDF Save R object to disk

selectData Select data for analysis from a larger data frame

tidalStations Table: Chesapeake Bay Program long-term tidal monitoring stations

usgsGages Table: Core USGS gages for CBP trend analyses
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baytrends is similar to
other R packages, Part 3

Typical help files include
a brief description of the
function, the usage and
arguments, etc.

Perhaps the most useful
aspect of the help files are
the examples.

Try copying the blue
highlighted code chunk from
the help panel to the
‘Untitled1’

.

Files Plots Packages Help Viewer

& 5 MW &l

R: Perform GAM analysis ~

gamTest {baytrends}

Perform GAM analysis

Description
Perform GAM analysis. Relies on mgev::gam to perform general additive model
Usage

gamTest (df, dep, stat, layer = HA, analySpec, gamTable = TRUE,
gamPlot = 10, gamDiffModel = HA)

Arguments

df data frame

dep dependent variable

stat station

layer layer (optional)

analySpec analytical specifications

gamTable gam table setting (set to FALSE to turn off table output)
gamPlot gam plot setting (set to FALSE to tumn off plotting)

gamDiffModel GAM model(s) used for computing differences on sub-annual/multi-period basis

Value

Returns a list with results

Examples

# specify parameter and station to analyze
dep <— '"secchi'

stat <- 'CB5.4'

layer <- "5

logTran <- FALSE

#Using gamTest

dfr <- analysisOrganizeData (dataCensored)

daf <- dfr[[1]]

analySpec <- dfr[[2]]

gamResult <- gamTest (df, dep, stat, layer, analySpec=analySpec)

[Package baytrends version 0.2.5 Index]

R Documentation

Highlight all of the rows copied
from the help panel and click
Run.

Explore the Console and Plots
that are created.

@7 Untitled1*

| DSourceon save | G A - i -
1
2  Tlibrary(baytrends)
3
4 B =specify parameter and station to analyze
5 dep <~ 'secchi’
& stat <- "CB5.4"
7 layer < 5"
8 logTran <- FALSE
9

10 #Using gamTest
11 dfr <- analysisOrganizeData (dataCensored)
12 df <- dfr[[1]1]

13 analySpec =- dfr[[2]]

14 gamResult <- gamTes:‘:-(d'F, dep, stat, layer, analySpec=analySpec)

—= Run
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Explore the help file to see what the function analysisOrganizeData does—its explanation is a
bit longer than the above function. (It is a workhorse for prepping data and doing initial
housekeeping to get ready for running the GAM analysis.)

3.0 Trend Analyses with R Markdown Scripts (.Rmd)

R scripts are simple files with lines of code. You already started writing an R script by following the
instructions in Section 2. It's not terribly different from other programming languages—Iines of code with
occasional comment lines to remind the programmer what the code is doing at key places. The usual
challenge is that simple code tends to generate output tables and plots, but then there is a lot of
backend work integrating tables and graphics into a report, as well as documentation.

There are a couple strategies for implementing analyses that can yield integrated reports that document
the performed analyses. Our strategy is to use R markdown. In the approach used here, we rely on
existing R packages including knitr and pander. There are certainly other options such as Sweave and
LaTeX. Our review of tools led us to believe that R markdown and knitr were an improvement over
Sweave and had a lower learning curve than LaTeX. The following website has some helpful
information if you want to delve into R markdown syntax:

http://rmarkdown.rstudio.com/authoring basics.html

The key advantage of R markdown is that you can integrate written text, tables, graphs and even the
code used to do the analysis into one report—documented and reproducible. The process of creating
these integrated reports is sometimes referred to as knitting, e.g., ‘knit a Word file’. While it is possible
to run individual lines in an R markdown script, it is usually intended to ‘knit’ the entire program at one
time. (See Section 4.0 for companion R script.)

The absolute best way to get started with R markdown script is to compare
the script with the generated output. So that is where we will start.

3.1 GAM Analysis

To begin, open R Studio and navigate — e [ [ _r
to the cbpTrends/Work30 folder. @ New Folder | @ | Delete (4] Rename | g More =

[ & - Dropbox - CBP - chpTrends ~ waork30

@ 0

We generally envision that you will set

& Mame Size Modified

up additional folders (e.g., Work31, &

Work32, ...) as needed to [[] @1 garmTrend-multi site.Rrd 103 KB Mar 22, 2017, 1:45 PM
store/manage different analysis tasks. [C] ®9 gamTrend-single site.R 28KB Mar 23, 2017, 4:01 PM
That is, it will likely be a good practice ] w3 template doex 14.2 KB Nov 8, 2016, 3:05 PI

as a beginning R user to store the R
markdown script that you run in the same folder as you generate the output.


http://rmarkdown.rstudio.com/authoring_basics.html
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Next, open gamTrend-multi site.Rmd in R Studio. (Refer to Section 1.0 to learn how to navigate
among folders in R Studio and open a file.) We wrote the R markdown script to be somewhat self-
explanatory and instructive.

When you open gamTrend-multi site.Rmd, you should also notice a new button ( =& knitword - gappear
in the top left pane in R Studio. After we modify the code to account for where you unzipped the
provided files, this will be the button to click and ‘knit’ a Word document. (You can also Knit HTML files.
An option for Knit PDF also exists, but requires additional software that we didn’t include in the
instructions.)

For now, however, simply click on gamTrend-multi site.docx. This Word document was created using
gamTrend-multi site.Rmd.

In the below graphic, we have overlaid the output MS Word file alongside the Rmd script. It is
instructive to compare the Rmd script on the left to the MS Word output. (For ease of reading, you will
probably find it easier to do this on your computer monitor than try to read the below graphic in detail.)

Some things to note:

reference_docx: template.docx — The Rmd script is expecting the word file ‘template.docx’ to be
in the project folder. The file, template.docx, includes some customization in the styles for headers,

font style, and spacing. You can change it if you like, but the included template.docx works pretty well
for the scripts that were included with baytrends.

ProjRoot <-'E:/Dropbox/CBP/cbpTrends/Work30' — This is the location of the script and the above
template.docx. You’ll need to modify this line of code depending on where you installed the files
under Section 1.0. (Note, the angle of the slashes [*/’] rather than the customary back slash [“\"] used

L] Roudi - @ & ) ¢ |
& FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILUNGS REVIEW VIEW DEVELOPER EndMote X5 Nuance PDF  Harcu.. =
-l - - Addins !
- o : #iFind -
| (Head - - clali=-=m == 0 T

= y Calibri (Head - |18 A K ha 3 7+ T aaBbCcDd AaBbCcD AaBbCeDe 25 Replace

. ] -|| 2 Replace

Gser - o Paste (BT U -abe x. X - A- - =- OH-[00- | TAbsract  TAuthor 7 Bibliogr. e

Clipboard = Font 5 Paragraph 0 Styles 5 Editing ~
| \ 1 ' 2 3 . s . 5 6 e

avigation >

HEADINGS | PAGES | RESUL» General Additive Model Analysis
[ e Date: March 23, 2017 21:15
Y # Month DD, YYYY HilM:SS P Load Libraries f

There are five primary sections to this report:

4 User Spedifications Load Libraries. Preloads required functions

this repors Project Folder +  User Specifications. Includes data fields far the analyst to update
+  Data Preparation. Basic information about the outcome of data preparation
oo data F1e)ds Tor the analyst o update Load : B + GAM Analysis. Selected results depicting GAM analysls
Forustion shout the utomms oF dobs preparstio Input Data Load - *  Close Qut. Compurer diagnostics
Selected results depicting GAM analysis N
Computer diagnostics Output Files -
4 _ Load Libraries
2 ) —
10~ ' lr loadtibraries, results=thide"} ) Data Inclusion Filter. - Library(baytrends)
51 library(baytrends
2 i ## Loading required package: lubridate
33

4 Data Freparation

34 # User Specifications : ##
Y Warning Messages - ## Attaching package: 'lubridate’
36 This section contains basic information about project folder, input and o
names, filtering values, and analysis specifications as updated by the analysts Record Count : ## The following object is masked from "package:base’:
7 #
) PR e
3~ s Project Folder Parameters = e

==} include the Fully Layers

oring outout. Thi3 13 the . ## Loading required packsge: mgcv

## Loading required package: nlme
- Stations h e g > "
## This is mgev 1.8-17. For overview type 'help{"mgcv-package™)’.

TEr —
45 kmitr:opts_chunkiset (dpi-150) 4 GAM Analysis . ## Loading required package: smmr(W
4 Secchi Depth -- Surface - ## Loading required packsge: dataRetrieval
##8 Load Station, Parameters and Layer Lockup Lists .
4 CB54 ## Loading required package: smrBase

Secchi Depth - Li...
Secchi Depth - N...

## Loading required package: smrGraphs

## This information is preliminary or provisional and is subject to revision

pk="stat i N - ; ine provl i e
s parassterList <- Toadoata(folders’. Secchi Depth - N. B It is being provided to meet the need for timely best science. The

i le=" par

Toadbata(foldara . Tea"Tayer Lulasp Y e ayers” 4 1E31 information has not received final approval by the U.S. Geological Survey

56  usgsGages <~ loadDataifolder *, file="usgsGages®.csv', (USGS) and is provided on the condition that neither the USGS nor the U.S.
phe=" 51 tetumber " Secchi Depth - Li... Government shall be held liable for any damages resulting from the authorized

P R . . . . or unauthorized use of the information. Altheugh this softuare program has
& CELUETLEE U 2 g i L Gt ey h| Secchi Depth - N... - been used by the USGS, no warranty, expressed or implied, is made by the USGS
faplo Blividan i carmineean m - L - e = =

PAGE1OF49 6547 worDs [R %3 m m B -——+ 0%
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in Windows.) Once you modify the project folder
(i.e., click on =& knitword -y,

tidalStations, parameterList, layerLukup, usg
user defined tables. baytrends is distributed with

location, you should be able to “knit” the document

sGages — As used here, the loadData function loads
default tables that work with the built in data set

described latter. (The methodsList table is optional and there is no built in table.)

The graphic shows the output associated
with loading the tidalStations csv file.

Load Station, Parameters and Layer Lookup Lists
Use this section to load local station, parameter and layer lists.

tidalStations <- loadData(folder="_.

JmySettings®, file="tidalStations*.csv’,

, . : A
Once you've taken some time to scan the || Pk="station")
. , Description Value
language in the R markdown, you'’ll probably | TyFieName tidalStations.cov
, . - 2) Folder Name ./mySettings
see that we've added some aides to facilitate | 3)primary ey station
. . . 4) Rows Read In 145 |
understanding what each step is doing. It 5) Columns Read In 15
. . . 6) Rows After Blank Rows Removed 145
serves as documentatlon and Instruction. 7) Columns After Blank Columns Removed 15
8) Rows After Duplicate Rows Removed 145
9] Rows After Duplicate PK Removed 145
‘ BHEHS- 0 - gamTrend-multi_site.docx [Read-Only] [Compatibility Mode] - Word 2 ® - 0O X
m HOME | INSERT DESIGN PAGELAYOUT REFERENCES MAILINGS REVIEW VIEW DEVELOPER EndNote X5 Nuance PDF Harcu... ~
l-- BB EEl ~ | Addin -~ R
©] gamTrend-multi site Rme* | dataCensored Consolas -1 <A A Aa- A | i=-i=E- == 8]0 AaBbCcDA AaBbCeD AaBbCeD( | | Rl:pme
- alg@l ¥ Qe - & - “Binsert - ~#Ru k) Pafle e BT U sex ¥ WA &~ fAbstract T Author 1 Bibliogr.. |- l:SeIe(I'
S- #2# Input Data Load Clipboard = Font = Styles Edliting A
& e values to the ri of the assignment oper. . . AR 1- t2 B D@ b5 e B QT &
i R A Navigation ke

Search documel

#df<-cbpDataA

HEADINGS | PAGES

nput Data Load

0-

RESUL»

The values to the right of the assignment operator (< -) specifies the input data set to analyze. For
df<-dataCensored, the analysis will use data sets that are pre-loaded into CBPstats. The load
command demonstrates how to load a user-created data frame. The user must rename user-created

- data to have a name of df.

Load Libraries
- #22 Ooutput File:

4_User Specifications

— df<-dataCensored

76 The tDt data file (== " statFile " ==
storing ults. Th put data file (= " hi gﬁl ) der
file Hame fur‘ stor g aluatiuns of change.
7 Load Station, Pare utput Files
T TR T ——. ’ The output data file (statFile) is a comma delimited output file name for storing results. The
30 chngFile _ File. path(ProjRoot. ' chngGAM Rmd output data file (chngFile) is a comma delimited output file name for storing evaluations of
o Input Data Load
81 change.
2 Outp! n : : :
83- 8 ) ) statFlle <- file.path(ProjRoot, ' statGAM Rmd.csv')
i eo# Duta Inclusion Filter & Analysis Parameter. Data Inclusion Filter... hngFlle <- file.path(ProjRoot, ' chngGAM Rmd.csv')
86 In the below code, the values to the right of the assignment operator ("<-") are r D Incl Fil & Anal P
specifications for Filtering the data or specifying certain aspects of the analysis. Th ata Inclusion Filter & Analysis Parameters

The next section of the Rmd script identifies the input and output data files. As shown in the below
graphic, the code loads a built-in data set called dataCensored and assigns it to a variable, df. The
variable df is short for ‘data frame’ which is analogous to a sheet or table of data. The next two lines of
code are commented and not executed, but show how the user code can load their own data set. If
these lines were run, they would result in loading a data file (with more than 120,000 records) available
in the cbpData folder and copy it to the variable df.

It's worthwhile to examine the structure of the loaded data. You can look at the online help by entering
?dataCensored at the Console prompt to get a list of variable names. You can also browse the data by
entering View(dataCensored) at the console. The first few lines of data are shown below. Much of the
data is similar to what you might find in a spreadsheet. What separates this data structure from a typical

spreadsheet is the handling of censored data.

10
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| dataCensored
-l " Filter
station date layer secchi chla do n ip podf PP wdp no23f-  nh4af tdn pn 1ss
5109 CB3.3C 108501-23 B NA 10.700 .00 1.070 0.0280 < 0.0070 0.0160-0.0230 <0.0120 04170 0.0830 0.9540 NA <4.00 -
5110  CB3.3C 1098501-23 § 1.30 12.000 1320 | 1.260 0.0300 < 0.0070 0.0180-0.0300 <0.0120 0.5460 0.0790 1.5100 NA <4.00
5111 CB3.3C 198502-13 B N& 16.000 NA 0.770 0.0430 < 0.0070 0.0330-0.0430 <0.0100 0.2030 =<0.0400 0.2030-0.6680 NA 22.00
5112 | CB3.3C 19850213 5 1.50 8.700 15.00 04180807 0.0210 < 0.0070 0.0110-0.0210 <0.0100 04160 <0.0400 0.4160-0.7010 NA 4.00
5113 CB3.3C 19850305 B N& 28.000 NA 0.978 N4 0.0108 N4 N& 0.1270 0.0890 0.5200 N& 108.00
5114 | CB3.3C 19850305 S 2.00 9.300 NA 1.420 NA 0.0040 NA NA 0.9500 0.0240 1.4800 NA <4.00
5115 | CB3.3C 1985%03-20 B NA 22.400 .60 0.879 0.0630 0.0038 0.046%5 0.016% 0.2380 0.0750 0.4480-0.6360 NA 26.50
5116 | CB3.3C 198503-20 § 2.00 12.000 13.60 | 1.000 0.0540 0.0032 0.0340 0.0200 0.56190 0.0270 0.6190-0.9940  NA 4.00
5117 CB3.3C 10850400 B NA 3g.000 7.20 1.200 0.0680 0.0023 0.0500 0.0080 03160 0.0770 0.8310 NA 12.00
5118 CB3.3C 1098504-00 S 1.50 2z.000 11.40 1.420 0.0440 0.0019 NA NA 0.7570 0.0500 1.2000 NA <4.00
5119 CB3.3C 10850423 B NA 42400 1.10 1.100 0.0480 0.0036 0.0290 00180 01830 01780 07910 NA 11.00 )

Note, how the first row of values for po4f and pp are “<0.0070” and “0.0160-0.0280". The po4f value is
a typical less-than value, i.e., the observation lies between 0 and 0.0070. The pp value is an interval
censored value and lies between 0.0160 and 0.0280. Interval censored values can arise from
computing parameters (either through summation, differencing, or averaging) when some components

2 TE o 00 - 1
° 23 HOME  INSERT DESIGN PAGELAYOUT ~REFERENCES MAILUNGS REVIEW VIEW DEVELOPER EndNoteX5 NuancePDF Harcu.. ~
2] +| e - 3~ addins -
- ErYy .| By |i= =a=|A i Find -
@ gamTrend-multi site.Rmd = Calibri (Head ~ |12 S &= - =[] AaBbCcDd AaBbCcT AaBbCcDr 35 Replace
i} v Q Knit - - *@insert » PRun *» G- - o P N Pac
=l Q |4 i ; Qinse PRun- [ S\ Paste BT U -obe X X w-A- = & -0~ || TAbstract  TAuthor YBibliogr. 5| | |y serect~
E 5+ Datx Toctusion FTter & Analysis Parameters o = 3 Selec
5
8 1In the below code, the values to the right of the assignment operator ("<-") are user  ™=JClipboard & Font ~ Paragraph n Styles ] Editing ~
specifications for Filtering the data or specifying certain aspects of the analysis. The V3
" analySpec <-19st() =+ command establishes the variable == ' analyspec’ == as a Tist . . v B ! 1 ! 2 [ L A T A 7
that will contain the user specifications selected in subsequent lines. We use the same Navlgatlon ata Inclusion Filter & Analysis Parameters
Tist, for the Seasonal Kendall test and GAM analyses, so all
5:“}2““‘“:5 ae she orpletences even though they wight not be used: The user - N In the below code, the values to the right of the assignment operator (*<-") are user specifications
shoul an:ﬁ';;;;msm v NULL.??,]; icate acceptance of default settings (e.o., Search document 0o~ for filtering the data or specifying certain aspects of the analysis. The analySpec <-list()
& . command establishes the variable analySpec as a list that will contain the user specifications
85 The first specification, project title, is assigned to == analySpecsanalyTitle "= in HEADINGS | PAGES | RESULy| | — selected in subsequent lines. We use the same list, analySpec, for the Seasonal Kendall test and
the next Tine of code. In this Tine of code =<' analySpec' ' == refers to the Tist and GAM analyses, so all specifications are shown even though they might not be used.
“analyTitle ' == refers to a variable within that the 1ist. The value to the right of 5 The user should specify NULL to indicate acceptance of default settings (e.g., analySpec$obsMin
‘the assignment operator ("<-") is the value assigned as the project title. = P uLL) e
89 i N -
90 The values <= paraneterListsparm™ "= and = tidalstationssstation’ "+ are pre-Toaded [ LAAALIDIaries o o . ‘
Took-up tables of valid parameters and stations, respectively. By default, if the amalyst 4 User Specimm ‘The first specification, project title, is assigned to analySpec$analyTitle in the nextline of code.
does not specify a Filter, these Took-up tables will be used. Filter specifications for S In this line of code analySpec refers to the list and analyTit1e refers to a variable within that the
character fields is a list of valid values. Ther specifying Project Folder . e y o
et 1o < e TS S g down selacting the ] - list. The value to the right of the assignment operator ("<-") is the value assigned as the project title.
::: Z:te to an]y ;a:::x d;g‘tb’a::dtut::j:;:;:g:: pl:ﬂ::lt s:ﬁ;:gitfx];ayers and sample Load Station, Para... N The b ist$parmand tidal . son are pre-loaded look-up tables of
C as. pqﬂmo ' is & date-time conversien function.) . valid parameters and stations, respectively. By default, if the analyst does not specify a filter, these
o1 . T — look-up tables will be used. Filter specifications for character fields is a list of valid values.
52 Other values specified by the user include layer aggregation avgTechnique’*"+* and nput Data Loa L Therefore, specifying analySpec$parameterfilt <~ c(*secchi', 'tn')willresultin down
. “Tayeraggoption’"'==), and minimum sanple size ( b e Output Files selecting the data set to only Secchi depth and total nitrogen, Default settings for layers and sample
Bl 1he bosic G Formilaes (e atiodel =) are also provided. = ganalpha’ "< rrw—"—— B date are 'B.,S', AP'/BE" and 1/1/1984 to present, respectively. (as . POSIXCt() s a date-time
indicates the confidence ]E\IE] (l e., 1-alpha) that should be used for GAM calculations. — conversion function.) -
9 .
96 " {r userspec » Other values specified by the user include layer aggregation (avgTechnique and
3; analyspec < 1ist( ) 4 Data Preparation - layerAggOption), and minimum sample size (obsMin).
99 # Analysis title i . Warning Messages The basic GAM formulaes (gamModel) are also provided. gamAlpha indicates the confidence level
100 analySpecsanalyTitle - '1985-2014 Example Analysis - N )
To1 Record Count L. (e, 1-alpha) that should be used for GAM calculations.
102 1
103 rListSparn analySpec <-1ist()
104 secchi’ ‘:h'a“ ’ d
105 e P AT L # Analysis title
2 i \ 4 . analygpe:g,analyrule <~ '1985-2014 Example Analysis’
108 1 i i1 < al Enj)jtat on
109 s < c("LE3.1", "CB5.4")
110 cistationFilt < tidalstations[tidal tM :
Fees
1z e 4 GAM Analysis !
us # csTayerFil < TayerLukupSayers analySpec$parameterfilt
114 analyspecslayerFilt = c(’s") - Surface -
1s
116 # Date filter 4 (B354
117 analySpecsdateFilt <~ as.POSTXck (c( 198401 01 1201512 N
118 analySpecssetTZ P ew. o 2016 Secchi Depth - Li...
119 -
120 # Layer aggregation (see 71 for more information) Secchi Depth - N...
121 analySpecSavgTechnique dian or mean) Sec _
122 analySpecslayerAggOption no aggregation
123 4 LE31
124 # Layer aggregation (see 71 'V"EIEIV’<GB on for more information)
125 analySpecsavoTechnique Secchi Depth - Li...
126 analyspecs layeragaOption
127 % 1: combine 'S Secchi Depth - N...
1701 | @ Chunke; userspec R Markdows Carrhi Nanth N EVIT I EREVLSy
[Corsole) PAGEG OF 50 6548 WORDS.

have some censoring. For example, what is TN if no23f and tkn are <0.10 and 1.00? We treat TN as
“1.00-1.10". As shown here, each column of water quality data is essentially represented by a lower
and upper bound. Less than values, like the po4f value of “<0.0070” have a lower and upper bound of 0
and 0.0070. Single values like the first record of chla of 10.7 essentially have a lower and upper bound
of 10.7. More effort is needed to create data sets of this type and the user is referred to the USGS’s
package smwrQW for more information.

Further down in the script, you’ll uncover the “Data Inclusion Filter & Analysis Parameters” section.

(You can find the section in the Word file by using the navigation pane.) This section allows you to
down select your data set to the portion of data you want to analyze while maintaining a single copy of

11



Appendix 2.1A

the master data file as well as making certain analysis decisions. Review the introduction to this section
to learn about how to make appropriate choices.

It is very important (actually required) that all parameters that will be analyzed exist in the parameterList
table. The parameterList table includes information about the full name and units of the parameter. It
also includes information about whether to log transform the data for the GAM analysis. Similar to
parameters, it is important (required) that all stations that will be analyzed exist in the tidalStations

[Jrsudo Eoo OO0
5 FLE HOME | INSERT DESIGN PAGE LAYOUT REFERENCES ~MAILINGS REVIEW VIEW DEVELOPER EndNote X5 Nuance PDF Harcu.. ~
ME- 4 | Addins -
ni @ nse ~%Run

= - . e Find ~
[y |calibri Head -[12-[ A" & B2~ A SiE-E- =3 d Fin

== 2L T AaBbCcDd AaBbCeD AaBbCCD( [~ , R

= D TAbstract  TAuthor  TBibliogr... [<|| |\ select~

Paste B I U -aeex X w-A- ===
Clipboard Font w Paragraph w Styles & Editing -~
. X v x [ . E"'l S .2 ' 3 Va4 R I RN 7
W@H\> Data Preparation
Search document 02~

‘This section trims down the data as per user specifications. Please review any warning messages.

HEADINGS | PAGES | RESUL» Warning Messages
B [~ Record Count
Load Libraries Beginning Number of Records: 7719
4 User Speifications Number of Records After Processing: 876
Project Folder
Parameters
Load Station, Para...
Table: List of Parameters.
Dep. Var. Paramster Name Units Log Tran. Inc.Conc. _GAM Dep. Var.
Secchi  Secchi Depth m  FALSE  Improving secchi
§ chla Chlorophylla (Corrected) ug/L TRUE  Degrading Inchla
Oip iRl o Total Nitrogen mg/L TRUE Degrading Intn
Data Inclusion Filter... nh4f  Ammonium (Filtered) ~ mg/L TRUE  Degrading Innhdf
- s Total SuspendedSolids  mg/L TRUE  Increasing Intss
214 This analysis implements a preliminary GAM analysis in R. i .
215 4 Data Preparation ayers
216
27 results='asis’, echo=FALSE, warnings=FALSE} 3 Warning Messages Table: List of Layers.
218 . .
5D Record Count LayerID _Layer Name
2o~ S Surface
20 Parameters
) Stations
222 Layers
321 T Table: List of Stations.
| = / - Station ID _ Latitude Longitude CB92Seg. Flow Adj. Gage Mth. Group
20 GAM Analysis CB54 378001 76.1747 CBSMHVA 01578310  VA-AL
st 4 Secchi Depth — Surface LE31 377593 766159 RPPMH 01668000  VA-Al
229 —
230 m. 1 4 (BSA
fsy } ! Secchi Depth - Li... GAM Analysis
= 3! Secchi Depth - N... This analysis implements a preliminary GAM analysis in R.
25 Secchi Depth - N...

table. This table includes information about latitude, longitude, segments, etc.

Filters can be added to down select by parameters, stations, date range, and layers. Data can be
aggregated by layer. We also include options for selecting the minimum sample size, which p-levels to
evaluate, and the level of detail for the output. (Review the instructions/documentation included with the
script for more details.)

In the below screen capture, you'll see that we use the function analysisOrganizeData for data
preparation. Besides returning a data set that has been prepared for analysis, you also get a brief
report on the variables, layers and stations to be analyzed.

At this point in the script, the data are ready for analysis. We set up a simple for loop to pass through all
the combinations of variables, layers and stations that were requested. The word file shows the output
for total nitrogen at CB5.4.

The closeout shows information about how long it took the program to run, what versions of the R
packages were running and information on who to contact with questions.
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(JStudio Tao 00, 1
T (W HOME | INSERT DESIGN PAGELAYOUT ~REFERENCES MAILNGS REVIEW VIEW DEVELOPER EndNoteXS Nuance PDF Harcu.. ~ I
7] -] &2 - B v addins + 1
.y R #iFina -
ori - - - e=3= A
AT HERRd =| L[y 5 [calibritead <11 ~[ & A A2~ A =35 8l T | AaBbCcDd AaBbCcD AaBbCcDe | e
T wall * - - L - v | G- - ¥ - rac
i 7 Q| it AR Soiine | iy Paste. . B I U -akx X =- O | TAbstiact  TAuthor  TBIbIOOL. = | [y Sefect-
184~ # Data Preparation - 3
185
186 This section trims down the data as per user specifications. Please review any warming Clipboard & oot B Paragraph B Styles & Editing o
o T . . x|t . E ) 1.2 ) 3 RRRE TR 5 . 6 AN
165~ #2# Warning Messages Navigation ) )
188 Total Nitrogen - Non-linear trend with Seas+int
150
L T Tt T e e e ) PSS Y » Search document £~ |2
192 Total Nitrogen-Surface at CB5.4
193 dfr < analysisOrganizeData (df, analySpec)
1 HEADINGS | PAGES | RESU[» N
105
196 " {r setUpForTrend, echo-FALSE, results="hide'} » jniia
197 # unpack dfr from analysisOrganizeData Chlorophyll a (C... g i
198 - dfr -~ z £
199  analySpec < dfr[["analySpec”]] 4 Total Nitrogen -- Surfa... e
200 g
201 # set up "to-do list” of variables, stations and layers 4 CB54 g o
202 depVarlist < analySpecsdepVarList Total Nitrogen . o £ 3
205 stationlist < analySpecistationList =
204 TayerList < analyspecsTayerList Total Nitrogen -... 2.
205 Z 2
206 deps <~ depVarListideps Total Nitrogen -...
207 stations < stationLististations
208 Tlayers <= layerListsTayers Total Nitrogen -... o T T T T T T
o 4 131 1985 1990 1995 2000 2005 2010 2015
211 - ##
- Total Nitrogen -... N Uncen - MnCng — Seas @ Cotht — 11 0
g ¢ o Anelyzis Ges —GAM O Sgn c an 101
214 This analysis implements a preliminary GAM analysis in R. Total Nitrogen -
215
T Total Nitrogen -... - Table: GAM Analysis of Variance.
:;' [ trendloop , results='asis', echoFALSE, waFnings=FALSE} » Total Nitrogen -... e Source  edf  F-stat p-value
N parametric terms cyear 100 05286 04676
ENg e aldenk nlde o) IR 4 SO (e = smoothed terms s(cyear) 1731 63767 <0.0001
220~ for (layer in layers) - d 693 23.9563 <0.0001
221 .H2(paste(depVarList deps—dep, "parmName”] , "--" ,layerList[layers—layer,"name"1)) 4 CB54  sldoy) 6 E .
222- for (stat in stations) { P . . tifcyeardoy) 538 17958 0.0001
223 _H3(stat) mmonium (Filt...
224 ganResult <~ ganTest(df, dep, stat, layer, analySpec-analySpec, gamDiffiiodel = 2) (T (i Table: GAM Parameter Coefficients.
z ) ) T Sl TS ) e Gl s - R Parameter  Estimate St B, tvalue p-value
b e e e e (e TS G et e Ammonium (Filt... . (Intercept) -0.526750 0.126936 41655 <0.0001
228 stat.gam < rbind(stat.gam, gankesult t. gan. result"11) 4 1631 cyear 0044284 0.060909 07270 04676
229 if(lexists("chng.gam™)) chng.gam <- gamResult[["chng.gam.res 1] €else - o 5 .
230 . chng-gam <~ rbind(chng. gam,ganmResuTt[["chng.gam.result"11) Ammonium (Filt... Table: GAM Diagnostics.
231 T A AIC__RMSE _Adj. R-squared
e Ammonium (Filt... N 18149 01892 04768
=0 (i (T Table: Estimates of Change from 1985-2014.
236 write.csv(stat.gam,file-statFile, row.names - FALSE) 4 Total Suspended Solid... ~ Calculation Estimate
237 write.csv(chng.gam,file=chngFile, row.names - FALSE) 4 CB54 Baseline log mean (geometric mean) -0.5669 (0.5673)
238 Current log mean (geometric mean) -0.8093 (0.4452)
= Total Suspended... - Estimated log difference 3
e port ol s ded Std. Err. log difference 00543
B P ST SRl s el i eors ], » otal Suspended... 959% Confidence interval for log difference (-0.3488, -0.136)
243 closenut() Total Suspended... @ Difference p-value <0.0001
244 Period of Record Percent Change Estimate (%) -2153%
245 Total Suspended...
21745 @ Chunk3: trendLoop * R Markdow .

In addition to the MS Word report, the program also creates two summary tables that are exported to
comma delimited files: statGAM_Rmd.csv and chngGAM_Rmd.csv. A list of parameters is provided in

Table 1.

Category

Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Station/Parm meta
Censoring

Censoring

Censoring

Censoring

Table 1. List of fields in statGAM.csv and chngGAM.csv.

Field

station

dep

layer

latitude

longitude
cbSeg92

state
stationGrpName
parmName
numObservations
yearRng
yearBegin
yearEnd

numyrs
yearRangeDropped
fracLT

fracUnc

fracint

Description

Station identifier

Parameter identifier

Sample layer

Station latitude

Station Longitude

CBP segment

State

Station Group

Full parameter name

Number of observations evaluated

Year range of data

Beginning year of data

Ending year of data

Number of years of data

Year range of data removed because of too high a level of censoring
fraction observations evaluated that are “<” censored
fraction observations evaluated that are uncensored
fraction observations evaluated that are interval censored
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Category
Censoring

Censoring

GAM model
GAM model
GAM model
GAM model
GAM model

GAM model
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM Coeff.
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
GAM ANOVA
POR change

POR change
POR change
POR change
POR change
POR change
POR change
POR change
POR change
POR change
POR change
POR change
GAM fit diagnostics
GAM fit diagnostics
GAM fit diagnostics

Field
fracRecen

recensor
depGAM
logTrans
gamOption
gamName
gamSelect

gamK
cyear.coeff
cyear.pv
interB.label
interB.coeff
interB.pv
interC.label
interC.coeff
interC.pv
interD.label
interD.coeff
interD.pv
interE.label
interE.coeff
interE.pv
p.cyear.pv
s.cyear.pv
s.doy.pv
ti.pv
p.inter.pv
ti.interA.pv
ti.interB.pv
ti.interC.pv
ti.interD.pv
ti.interE.pv
edfMin
edfMinSource
FstatFlag
mn.doy

sa.sig.inc
sa.sig.dec
por.diffType
por.bl.mn
por.cr.mn
por.bl.mn.obs
por.cr.mn.obs
por.abs.chg
por.abs.chg.obs
por.pct.chg
por.chg.pv
aic

rmse
adjr2

Description

fraction observations evaluated that are a negative number and were

recensored

value the negative values were recensored to

Parameter identifier for GAM

Were the data log transformed

GAM formula number (analySpecSgamModels)

GAM formula name (analySpecSgamModels)

Setting for select argument in mgcv::gam function (either TRUE or
FALSE)

Setting use in s(cyear, k=gamK)

GAM parameter cyear coefficient

GAM parameter cyear p-value

GAM parameter intervention B coefficient

GAM parameter intervention B coefficient

GAM parameter intervention B p-value

GAM parameter intervention C coefficient

GAM parameter intervention C coefficient

GAM parameter intervention C p-value

GAM parameter intervention D coefficient

GAM parameter intervention D coefficient

GAM parameter intervention D p-value

GAM parameter intervention E coefficient

GAM parameter intervention E coefficient

GAM parameter intervention E p-value

GAM parametric cyear p-value

GAM smoothed cyear p-value

GAM smoothed doy p-value

GAM smoothed trend interaction [ti(cyear,doy)] p-value
GAM parametric intervention p-value

GAM smoothed trend interaction, intervention A p-value
GAM smoothed trend interaction, intervention B p-value
GAM smoothed trend interaction, intervention C p-value
GAM smoothed trend interaction, intervention D p-value
GAM smoothed trend interaction, intervention E p-value
Minimum edf value from ANOVA table

Source of minimum edf value from ANOVA table

Indication of unreliable F-stat statistic in from ANOVA table
**obsolete** previously: Day of year used to construct seasonally
adjusted model

Periods of significant increases

Periods of significant decreases

POR comparison using regular or adjusted mean

POR baseline mean (expressed as log value if logTrans=TRUE)
POR current mean (expressed as log value if logTrans=TRUE)
POR baseline mean (observed units, geo. mean if logTrans=TRUE)
POR current mean (observed units, geo. mean if logTrans=TRUE)
POR absolute change (diff. of log values if logTrans=TRUE
POR absolute change (observed units)

POR percent change estimate (%)

POR change p-value

Akaike information criterion

Root mean squared error

Adjusted R squared
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Category

Analysis Spec.
Analysis Spec.
Analysis Spec.
Analysis Spec.
Analysis Spec.
Customized Change
Customized Change
Customized Change
Customized Change
Customized Change
Customized Change
Customized Change
Customized Change
Customized Change

Field

periodName*
seasonName*
periodStart*
periodEnd*
seasonMonths*
gamDiff.diffType
gamDiff.bl.mn*
gamDiff.cr.mn*
gamDiff.bl.mn.obs*
gamDiff.cr.mn.obs*
gamDiff.abs.chg*
gamDiff.abs.chg.obs*
gamDiff.pct.chg*
gamDiff.chg.pval*

*available in chngGAM.csv output

Description

User-supplied period name (see analySpecSgamDiffPeriods)
User-supplied season name (see analySpecSgamDiffSeasons)

Start years used to compute difference (see analySpecSgamDiffPeriods)
End years used to compute difference (see analySpecSgamDiffPeriods)
Months used to compute difference (see analySpecSgamDiffSeasons)
Comparison using regular or adjusted mean

Baseline mean (expressed as log value if logTrans=TRUE)

Current mean (expressed as log value if logTrans=TRUE)

Baseline mean (observed units, geo. mean if logTrans=TRUE)

Current mean (observed units, geo. mean if logTrans=TRUE)

Absolute change (diff. of log values if logTrans=TRUE)

Absolute change (observed units)

Percent change estimate (%)

P value associated with absolute change
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